
Workshop Topic 
Introduction to Rendering and 
Textures

Rendering in VectorWorks is where 
you start to enjoy your 3D Models, 
where you make them come to life. 
This workshop is an introduction to 
rendering (which is pretty easy), but 
rendering is nothing without textures 
which can make your models into 
something special.

Q & A

Questions from users and the answers 
from Jonathan. 

“What is the best way to create 3D 
fillet welds for 3D steel details, 
e.g.steel brackets etc?”

  

Extended Podcast 036

This podcast shows you how to set 
your dimensions and units so that you 
can measure areas for a worksheet in 
one unit type but put dimensions on 
the page in a different unit.

 

Extended Podcast 037

This podcast shows you how to 
quickly edit viewports. At the last 
user group meeting I showed some 
quick ways to edit viewports, and it 
seemed that not many people knew 
these tricks...

c a d s u p p o r t o n l i n e . c o m  issue 0704

This newsletter is designed to work as an on-line user group, based on the successful New Zealand VectorWorks User 
Group format. Each month we cover a main topic in a workshop for most of the newsletter then have a page of general 
questions and answers. In this news letter you will find a link to the workshop topic, a link to the questions and answers 
and links to extended podcasts (tips and trick movies). 

http://learn.archoncad.com/?p=1236
http://learn.archoncad.com/?p=1238
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If you use a lot of classes, for things like internal walls, external walls 
etc, then you can you the class set up dialog box to assign textures as you 
draw. Using classes for things like the windows and doors is a great way 
to get the textures on them, and it’s really fast. Using this method you can 
set up your file for the textures, even without any textures in the file yet. 

Also consider using a lot of symbols. I did a project with a lot of small 
detailed corbels under the eaves. These were not symbols and the textures 
that I assigned had to be assigned to each object individually. If the 
corbels had been symbols I could have assigned the texture to one object 
and they would all have been updated together.

When you are setting up a model for rendering, the first thing to do is to 
plan where your render. Where will you be standing, what will you be 
looking at. This will help you to decide on what you need to draw and 
what you can leave out. If you don’t know what areas you will be render-
ing then you will have to draw the whole building and assign textures to 
the all the objects in the drawing. If you have used a lot of classes, like 
for internal walls and furniture,  work out if some of these classes can be 
turned off to speed up the rendering process. 

Rendering

I think that Rendering is 
one of the fun parts of 
VectorWorks, You can see 
you building coming to life. 
But it can take a long time 
to get nice results.

While RenderWorks can be 
fun it can also be very time 
consuming. On more than 
one occasion I have been 
have stopped to look at the time and wondered where the day has gone. 

Some of the renderings can take several minutes to render. The original 
of this image took ages to get looking right. Each rendering took over 5 
mins. 

If you are going to start rendering check your computer for memory and 
speed. 

You should be getting the fastest computer you can afford with a 
minimum of 1GB. If I’m buying a computer these days, I’m getting at 
least 2GB RAM installed. 

2.1	 Preparation

Create the model

Obviously you have to create a model to render. When you create your 
model think about texturing the model as you draw. This means think 
about the objects you draw and how they will be textured.

I n t r o d u c t i o n  T o  R e n d e r i n g  a n d  T e x t u r e s
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Line Render Options

cadmovie020

•	 From the Menu Bar choose 
View > Rendering > Line 
Render Options...

•	 Change the smoothing 
angle to 30º. The 
smoothing angle 
controls the facets that 
you see on a hidden line 
rendering. Setting an 
angle of 30º will show 
very few of the facets.

•	 You can also choose 
the settings for sketch 
rendering (we’ll cover 
this later).

•	 Click on the OK 
Button. 

2.2	 Preferences

VectorWorks Preferences

VectorWorks Preferences affect every VectorWorks file. 

cadmovie019

•	 From the Menu Bar choose 
Tools > Options > VectorWorks Preferences...

Under the Display tab there is 
the control over the display of 
light objects and 3D Loci. 

I usually choose the “Only in 
Wireframe” option  so that 
in wireframe I can see the 
lights and move them around, 
but when I render the view 
the lights are not displayed, 
just the output from the light 
source is visible.

Under the 3D tab are 
controls for the resolution 
of the conversion resolution 
(how finely 2D shapes are 
converted to 3D faces), and 
how VectorWorks retains the 
3D geometry in is memory. 
If you choose “Always” then 
VectorWorks should keep the 
model rendered in OpenGL 
when you walk  through the 
building.

•	 Click on the OK Button. 

http://learn.archoncad.com/?p=1243
http://learn.archoncad.com/?p=1240
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RenderWorks Camera

The RenderWorks Camera tool allows you to make a view similar to the 
Set 3D View, but it’s an object that you can move around and edit, so it’s 
more useful that the Set 3D command.

cadmovie021 

•	 Open a file.

•	 From the Visualisation toolset 
choose the Renderworks 
Camera tool.

•	 Click once for the camera 
position.

•	 Move the cursor into the object. 
This is the centre of your view, 
i.e. what you are looking at, click 
once.

•	 The first time you use this tool you will see 
this dialog box where you can set some of the 
options for the RenderWorks Camera tool.

•	 The RenderWorks Camera stays 
on the drawing. This allows you 
to move the camera if you don’t 
like the position of the camera. 

•	 On the Object Info Palette, click on the 
Display Camera View button.

http://learn.archoncad.com/?p=1246
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•	 VectorWorks shows you the 
view.

•	 Use the Object Info Palette to change 
the display settings for the RenderWorks 
Camera. 

•	 You can also change the setting of the camera 
lens if you want to edit the perspective of the 
view. 

•	 VectorWorks updates the view when you hit the Enter or Return 
key.

2.4	 Rendering Types

Rendering is a way of looking at your 3D model with light and shade. 
There are several ways of doing this and each different way has some 
advantages and some disadvantages.

cadmovie022

•	 Open a file.
 

Open GL

•	 From the Menu bar Choose  
Views > Rendering > OpenGL.

•	 Now you can see a view with light 
and shade and it makes it easier to 
read the object.

•	 OpenGL rendering is fast but not 
very detailed.

http://learn.archoncad.com/?p=1248
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OpenGL Options

•	 From the Menu bar Choose  
Views > Rendering > OpenGL Options.

•	 If you set a high level of detail VectorWorks 
will take longer to render the view. Each of 
these option will make the view more detailed 
and therefore it will take longer to render.

 
•	 Try changing the details from low to high and see if the results are 

different.

Fast RenderWorks

•	 From the Menu bar Choose  
Views > Rendering > Fast 
RenderWorks.

•	 This is fast but without shadows it’s 
not much to look at.

Fast RenderWorks with shadows

•	 From the Menu bar Choose  
Views > Rendering > Fast 
RenderWorks With Shadows.

This is a good rendering mode if you want it quickly. It’s a bit crude, 
but it is FAST!

Final quality RenderWorks

•	 From the Menu bar Choose 
Views > Rendering > Final Quality 
RenderWorks.

•	 This one of the best rendering options 
available, but it is also fairly slow. 
Some views can take several minutes 
. 

Custom RenderWorks

•	 From the Menu bar Choose  
Views > Rendering > Custom 
RenderWorks.

This method allows you to control the 
quality the best rendering available, 
allowing you to balance quality with 
the time you have available.
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RenderWorks Options

•	 From the Menu bar Choose  
Views > Rendering > Custom RenderWorks 
Options...

•	 The RenderWorks options control the rendered 
results if you use Custom RenderWorks or if 
you use the render bitmap tool. Each of these 
choices can dramatically improve the rendered 
image, but they will also add to the time that it 
takes to render an image. 

•	 Ray Traced shadows are crisp but slower, 
shadow mapped shadows are not as crisp but 
they are faster. 

•	 Ray Tracing on reflective objects like 
marble, mirrors and glass looks better, the 
recursion level is how many bounces of light 
VectorWorks considers.

•	 Generally you would use textures. If you don’t 
use textures VectorWorks will use the colour 
of the object as assigned by the attributes palette. Glass will not be 
transparent if you do not turn on the Use Transparency. 

•	 Anti-Aliasing reduces the look of jagged pixels on the screen and 
make the printed image look better.

Final Quality Radiosity

•	 From the Menu bar Choose 
Views > Rendering > Final Quality 
Radiosity.

•	 This one of the best rendering options 
available, but it is also the slowest. 
Some views can take several minutes 
. 

Be careful if you choose the Custom Radiosity 
option. I’ve played with the options to increase 
the quality of the rendering, but if you increase the 
energy and accuracy, you might find that the render-
ing time increases dramatically. 
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Textures

Textures are the things that make you drawing stand out and have a bit 
of zing. They can be created inside VectorWorks and can be created from 
digital images, or from shaders (built in mathematical descriptions of 
textures).

You should consider having an office library to store resources like 
symbols, layer and class standards and textures. It will be a lot easier for 
you to find textures that you like using in your library rather that hunting 
through all your old files.

cadmovie023

Creating Textures 

•	 Open a file.
•	 Open the resources palette and right click on 

an empty area of the Resource Brower.
•	 Choose New Resource in... > Texture. 

•	 This dialog box allows you to 
create and edit textures.

•	 Name your texture. We will 
create a wood texture, some sort 
of pine timber. 

•	 Name the timber Wood.
•	 Click on the pop-up menu for 

colour.
•	 This will open a menu for you to 

choose the type of colour. It could 
be a scanned image, or one of the 
built in shaders.

•	 Choose Pine.

•	 After you have chosen pine, you can click 
on the edit button directly below Pine, this 
opens the Edit pine dialog. Here you can 
make your texture look like real pine by 
changing the colour, grain, gnarl, etc. 

•	 Click on the OK button.

•	 Change the Size to 40mm 
(1.75”).

•	 Change the Obj Size to 50mm 
(2”), This means that the preview 
object is 50mm in size. This 
should give you a good idea of 
the grain on our object. 

•	 Click on the OK button.

This is a great way to get an idea of what the texture will look like on 
your object.

http://learn.archoncad.com/?p=1251
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Assigning Textures Directly

•	 Select the object that you want to assign 
the texture to.

•	 On the Resource Brower double click on 
your Wood texture. 

•	 To edit the texture, right mouse click on the 
Wood texture on the Resource Brower.

•	 Choose Edit from the pop-up menu.
•	 Edit the pine texture to match the picture.

•	 It is important to edit the textures so that 
they look correct.

Tip: 
you can also Drag and drop textures from the Resource Browser 
onto a 3d object to assign the textures.

Assigning Textures Using Classes

If you set up your file early on to use textures for specific classes that 
you want to texture then you have an advantage when it is time to assign 
the textures. By going to the classes dialog you can then texture all the 
objects of a specific class.

cadmovie024

•	 Create a new texture.
•	 Name it Marble.
•	 Use a Marble texture from the 

Color pop-up menu.

http://learn.archoncad.com/?p=1253
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•	 Edit the marble so that it has better colours 
and grain.

•	 Click on the OK button.
•	 Click on the OK button.

•	 Open the classes Setup dialog, 
from the Menu Bar choose: 
Tools > Organization...

•	 Double click on the Floor class. 
•	 Set Marble and the texture for the class.
•	 Click on the OK button.

•	 If you get a dialog box asking if 
you want to assign the texture to 
all objects say yes always.

•	 If you use objects in VectorWorks 
there is often the choice to use 
classes for parts of the objects. 
This makes it very easy and 
quick to add textures to objects. 
It also makes it easy to control the 
textures in a project. 

•	 Select the floor object. 
•	 Assign the floor object to the Floor class.

Mapping Textures 

Mapping textures is the way that VectorWorks (and the other CAD 
programs) drape the textures of the objects. One of the tricks to getting a 
good render is to get the texture mapping right. The wood texture has to 
appear the right size for the rendering to look right. When we created the 
texture we set the preview on the object to be 50mm, this was to give us 
an idea of what the texture would look like on a reasonable sized object.

cadmovie025

•	 Open a file.
•	 This file has an object with textures already 

in it. .
•	 Open the Object Info Palette. If it is not 

open go to the Menu Bar and choose: 
Window > Palettes > Object Info.

•	 Click on the Tab for Textures. 
•	 This is used to apply textures to 

VectorWorks objects and also allows you 
to adjust the mapping. 

•	  In this case the easiest way to edit the 
mapping of the texture is to edit the texture. 

•	 Using the Resource Brower. Find the wood 
texture and right mouse click on it. 

•	 Choose Edit.

http://learn.archoncad.com/?p=1255
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•	 On the Edit Texture dialog, 
change the size to 150mm (6”). 
That is over 3x bigger than it was. 

•	 This will cause the texture to look 
too big.

•	 Click on the OK button.
•	 You can now see the size of the 

texture that we created is not 
suitable for our timber block, , 
although it may be great for a far 
away view.

Often you need to exaggerate textures to 
get them to read correctly in a rendered 
image.

Another example of this would be to make a plant texture for small 
plants. I was with some clients the other day and they wanted to make 
some simple textures for plants. 

cadmovie026

•	 Open a file. We’ll make a plant texture and 
some grass.

•	 Click on the Resources Menu on 
the Resource Browser. 

•	 Choose :  
New Resource > Renderworks 
Texture...

•	 Choose the Granite texture. 

•	 Name the texture.
•	 Set the review options to a 

sphere so that you can see what 
the texture would look like on a 
round object.

•	 Set the size of the preview to 
500mm, as this is the size of the 
plant. 

http://learn.archoncad.com/?p=1259
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•	 This will let you see the texture 
on the plant accurately.

•	 Change the size of the texture 
until the granite looks like the 
size of leaves.

•	 Click on the Edit button on the Granite 
so that you can change the colour of the 
granite. 

•	 If you set some parts of different 
greens, and one part to the flower 
colour (in this case the white 
flower for a camellia), you get a 
random spread of flowers. 

•	 Apply the texture to the plant.

cadmovie027
•	 To make the grass we can use a similar process, but for grass I might 

make a plain colour with a bump map to make the ground look a bit 
like grass. 

•	 Use the Resource Browser to create a new 
texture.

http://learn.archoncad.com/?p=1262
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•	 Choose a Plain Color.
•	 Click on the Edit... button to get 

a nice green colour.
•	 Set the preview options so that 

you have a sphere 500mm (2’).

•	 Set a bump for the grass. I’ve 
used Rough, Solid.

•	 Set the texture size so that the 
texture looks suitable. 

•	 Click on the Edit... Button to change the 
settings to suit. 

  

•	 Now you can see the preview. Get 
the preview looking good and 
then when you apply the texture, 
it looks better. 

•	 Apply the grass texture to the 
base. Now we have a plant on a 
grass lawn....
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Texture From Image

Creating a texture from an image allows you to make any texture that you 
want. You can scan an object, a logo, you can use a digital photo or you 
can make up an image in Photoshop.

cadmovie028

•	 Open the file Render_5.sta from the 
exercises folder.

•	 Right click on the Resources Browser.
•	 Choose  New Resource in... > 

RenderWorks Texture...

•	 To create an texture from an 
image you need to create the 
image. I have already made 
one for you and placed it in the 
exercises folder.

•	 On the texture Dialog Box choose 
Image Color from the pop-up 
where it says Color. When you 
choose this from the pop-up, 
VectorWorks wants to know 
which file to import. 

•	 Find the image.psd file in the exercises 
folder.

•	 Click on the OK button.

•	 Set the colours to Millions of colours and 
size 100%...

•	 Click on the OK button.

•	 Tile image horizontally and vertically, 
otherwise your texture will be a small 
square in the middle. 

•	 Click on the OK button.

•	 Click on the Bump pop-up menu.

http://learn.archoncad.com/?p=1264
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•	 I have made an image file that will be a 
bump on the texture. 

•	 Choose the bump.psd file from the 
exercise folder. 

•	 Click on the OK button.

•	 Set the colours to thousands and the size 
to 100%.

•	 Click on the OK button.
•	 The softness controls how the bumps 

appear, with soft edges, or with sharp edges. 
To get real control over the transition from 
the base texture to the bump, make sure 
that you have soft edges on your image.

•	 This is the image with the bump. 
You can also control the size of 
the texture.

•	 Click on the Set by Image button 
to set the size of the texture.

•	 Change the image size to 30mm 
(1.25”). 

•	 Click on the OK button.
•	 Apply this texture to your object 

and render the view in Final 
Quality RenderWorks.
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Q u e s t i o n s  a n d  A n s w e r s

Q.  “What is the best way to create 3D fillet welds for 3D 
steel details, e.g.steel brackets etc?”

There are two ways to place a 3D fillet. The first method is used for 
placing 3D fillets on two NURBS surfaces, the second method is used to 
fillet a solid object. 

Let’s look at the first method. If you 
have a solid object like this one, you will 
have to convert it to NURBS curves, 
using the command form the menu bar: 
Modify > Convert > Convert to 
NURBS.

•	 Select the two NURBS surfaces.
•	 Choose 

Model > 3D Power Pack > Create Fillet 
Surface... 
from the Menu Bar. 

•	 Choose the options that you want. You 
will have to try different options here. 
I tried some worked really well on a 
larger object but didn’t work on a smaller 
object. 

•	 Click on the OK button. 

•	 The fillet surface is independent 
from the NURBS curves that you 
started with. This means that you 
can change the colour or texture 
of the fillet. 



©Jonathan Pickup	 cadsupportonline  - Issue 0704

Page 17

Let’s look at the second  method. 
This method needs two solid objects 
that are added together to make a 
Solid object. Extrude two or more 
objects and then use the command: 
Model > Add Solids to make 
them into one solid addition, or 
Model > Subtract Solids... To make a 
solid subtraction. 

•	 Choose the Fillet Edge Tool 
from the 3D Modelling toolset. 

•	 Click on the edges that you want 
to fillet. If you hold down the 
shift key you can select more 
that one edge. 

•	 Click on the green tick on the 
Mode Bar. VectorWorks places 
the fillet, but it is now part of the 
object, so you can’t change the 
colour of the fillet separate from 
the main object. 


